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Read this Instruction Manual thoroughly before using the product. 

 

Thank you for purchasing Shimadzu analytical instrument workstation AOC-6000 Software for 
GCMSsolution. 

 

This manual describes the procedures for operating this product. Read this manual thoroughly before using 
the product and operate the product in accordance with the instructions in this manual. 

Also, keep this manual for future reference. 

This manual assumes that the reader is knowledgeable of basic operations of Windows. For the operation 
of Windows, refer to the instruction manual that comes with that product. 

 

Important 

 

• If the user or installation location changes, ensure that this Instruction 
Manual is transferred with the product. 

• If this manual is lost or damaged, immediately contact your Shimadzu 
representative to request a replacement. 

• To ensure safe operation, contact your Shimadzu representative for 
product installation, adjustment, or reinstallation (after the product is 
moved). 

Notice 

 

• Information in this manual is subject to change without notice and does 
not represent a commitment on the part of the vendor. 

• Any errors or omissions which may have occurred in this manual 
despite the utmost care taken in its production will be corrected as soon 
as possible, although not necessarily immediately after detection. 

• All rights are reserved, including those to reproduce this manual or parts 
thereof in any form without written permission from Shimadzu 
Corporation. 

• Microsoft and Windows are registered trademarks of Microsoft 
Corporation in the United States and/or other countries. Other company 
names and product names mentioned in this manual are trademarks or 
registered trademarks of their respective companies. 

The TM and  symbols are omitted in this manual. 

• Microsoft Windows 10 Operating System is referred to as “Windows 10”. 

© 2016-2022 Shimadzu Corporation. All rights reserved. 

Original version is approved in English.
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Shimadzu provides the following warranty for this product. 
 

1. Period: Please contact your Shimadzu representative for information about the 
period of this warranty. 

2. Description: 
 

If a product/part failure occurs for reasons attributable to Shimadzu 
during the warranty period, Shimadzu will repair or replace the 
product/part free of charge (including USB dongles). However, in the 
case of products which are usually available on the market only for a 
short time, such as personal computers and their peripherals/parts, 
Shimadzu may not be able to provide identical replacement products. 

3. Limitation of Liability 1. In no event will Shimadzu be liable for any lost revenue, profit or 
data, or for special, indirect, consequential, incidental or punitive 
damages, however caused regardless of the theory of liability, 
arising out of or related to the use of or inability to use the product, 
even if Shimadzu has been advised of the possibility of such 
damage. 

2. In no event will Shimadzu's liability to you, whether in contract, tort 
(including negligence), or otherwise, exceed the amount you paid 
for the product. 

4. Exceptions: Failures caused by the following are excluded from the warranty, even 
if they occur during the warranty period. 

  1. Improper product handling 
2. Repairs or modifications performed by parties other than 

Shimadzu or Shimadzu designated companies 
3. Product use in combination with hardware or software other than 

that designated by Shimadzu 
4. Computer viruses leading to device failures and damage to data 

and software, including the product's basic software 
5. Power failures, including power outages and sudden voltage 

drops, leading to device failures and damage to data and software, 
including the product's basic software 

6. Turning OFF the product without following the proper shutdown 
procedure leading to device failures and damage to data and 
software, including the product's basic software 

7. Reasons unrelated to the product itself 
8. Product use in harsh environments, such as those subject to high 

temperatures or humidity levels, corrosive gases, or strong 
vibrations 

9. Fires, earthquakes, or any other act of nature, contamination by 
radioactive or hazardous substances, or any other force majeure 
event, including wars, riots, and crimes 

10. Product movement or transportation after installation 
11. Consumable items 
Note: Recording media such as CD-ROMs are considered 

consumable items. 
 
• If there is a document such as a warranty provided with the product, or there is a separate contract agreed upon that 

includes warranty conditions, the provisions of those documents shall apply. 

• Warranty periods for products with special specifications and systems are provided separately. 
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Indications Used in This Instruction Manual 

Warnings, Cautions and Notes are indicated using the following conventions, and the following symbols are 
used in this manual: 

Indication Meaning 

 
Indicates a potentially hazardous situation which, if not avoided, may 
result in minor to moderate injury or equipment damage. 

 
Emphasizes additional information that is provided to ensure the 
proper use of this product. 

 Indicates the location of related reference information. 

[   ] Indicates the names of buttons, menu options, setting options, 
windows/sub-windows, and icons that are displayed in a window. 

Example: Click [OK]. 
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1 Description 
This software installs Instrument Control Solution. Instrument Control Solution enables method 
development and analysis using the AOC-6000 Series (AOC-6000 Plus, AOC-6000) with GCMSsolution. 

 
・ This software can be used in the following instrument environment. This software requires the same 

computer environment as GCMSsolution. 

Sampler: AOC-6000 Plus, AOC-6000 
GC-MS: GCMS-NX Series, GCMS-QP2020, GCMS-QP2010 Series, 

GCMS-TQ Series 
Workstation: GCMSsolution Ver. 4.30 or later 
OS: Windows 10 Professional 64bit or 
 Microsoft Windows 7 Professional SP1 
 .NET Framework 4 
Firmware: Refer to the table below. 

 
Correspondence table between AOC-6000 Control Software, Instrument Control Solution, and Firmware 

(✓:Compatible, -:Not compatible) 

 

・ Ecology mode, which saves electric power and carrier gas during idle time, is not applicable for 
AOC-6000 Series. Please set a temperature of a syringe, an agitator, the SPME fiber conditioning 
during idle time, “Standby Temperature”, in the PAL terminal of AOC-6000 Series. 

・ Controlling the AOC-6000 Series increases the load on the computer. When using the AOC-6000 
Series continuously, reboot the computer approximately once every two weeks. 

 

AOC-6000 
Control 

Software 

Instrument 
Control 
Solution 

Firmware 

AOC-6000 AOC-6000 Plus 

2.1.3 2.2.8 2.3.7 3.1.6.2 3.1.6.3 

Ver. 1.0 3.0.143.0 ✓ - - - - 

Ver. 1.1 3.0.158.0 - ✓ - - - 

Ver. 1.2 3.1.31.0 - ✓ - - - 

Ver. 1.3 3.1.31.0 - - ✓ - - 

Ver. 2.0 3.2.2.0 - - ✓ ✓ ✓ 

Ver. 2.1 
3.2.3.1 ✓ ✓ - - - 

3.2.4.0 - - ✓ ✓ ✓ 
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2 Installing 

 
GCMSsolution Ver. 4.30 or later must already be installed and firmware of AOC-6000 Series must 
already be updated to the version described in "1. Description” before the AOC-6000 software is 
installed. 
 
This software and the AOC-5000 Plus control software cannot be installed on one computer. If the 
AOC-5000 Plus control software is installed, uninstall it and then install this software. 

When using a computer on which .NET Framework has not been installed, the installation program of 
this software automatically installs .NET Framework. It is not necessary to perform a procedure to 
install .NET Framework separately. 
 
Also, the software will not run by simply copying the contents of the CD-ROM to the computer hard 
drive. Be sure to install the software using the proper method. 

2.1 Installing the Software 

1) Exit the GCMSsolution. 

2) Insert AOC-6000 control software installation disk into the CD-ROM drive. 
This automatically starts the installation program. 
If the "Do you want the following program to allow changes to this computer?" message appears, click 
[Continue]. 
 
 

 
 

 

• If the installation program does not start, click [Start] on the taskbar, point to [All 
Programs] and [Accessories], and click [Run]. 

• In the [Run] sub-window that is displayed, enter "E:\AUTORUN.EXE" in the 
[Open] text box, then click [OK]. (Specify the applicable CD-ROM drive for the 
"E:" portion.) 
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3) The [Shimadzu ISS Shared Components] program is automatically installed.  
 

 
 

 
It takes a while to install the [Shimadzu ISS Shared Components] program. Do not click the [Cancel] 
button during installation. 
 
After a while, the [Welcome to the InstallShield Wizard for Instrument Control Solution] sub-window 
opens again. 
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4) Click [Next >]. 
The [Instrument Setup] sub-window opens. 

 
 

 
Do not change the settings in this sub-window. 

5) Click [Next >]. 
The [Ready to Install the Program] sub-window opens. 
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6) Click [Install]. 
Installation of the [Instrument Control Solution] program starts. 

 
 

 
It takes a while to install the [Instrument Control Solution] program.  
 
When installation is completed, the [InstallShield Wizard Completed] sub-window opens. 

 

7) After confirming that “InstallShield Wizard Completed” is displayed, Click [Finish]. 
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2.2 Uninstalling the Software 

When uninstalling AOC-6000 control software, be sure to uninstall 2 programs. 

1) Select [Control Panel] on the [Start] menu. 
The [Control Panel] sub-window opens. 

2) Click [Programs and Features]. 

3) Double-click [Instrument Control Solution] from the list of programs. 

 

4) A message appears to confirm uninstalling (removing) the program. Clicking [Yes] uninstalls 
(removes) the Instrument Control Solution program file.  
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5) Double-click [Shimadzu ISS Shared Components] in the list of programs.  

 

6) A message appears to confirm uninstalling (removing) the program. Clicking [Yes] uninstalls 
(removes) the Shimadzu ISS Shared Components program file. 

 

 



3 Initial Setting 

8  AOC-6000 Control Software 

3 Initial Setting 

3.1 Connecting AOC-6000 Series with a Computer 

Connect the AOC-6000 Series with a computer via Ethernet using a LAN cable. 

 

• If the computer is not connected to the backbone LAN, setting the following IP addresses is 
recommended. 

 AOC-6000 Series Computer 

IP Address 192.168.99.230 192.168.99.210 

Subnet Mask 255.255.255.0 255.255.255.0 

Default Gateway No setting No setting 

 
• For the connection to the backbone LAN, the IP address, subnet mask, and default gateway need to 

be set. For their settings, consult with the network administrator. 

Below is the procedure to directly connect the AOC-6000 Series with a computer (peer-to-peer 
connection). 

1) Switch the AOC-6000 Series power ON. Wait until the LED on the AOC-6000 Series turns green and 
the PAL terminal presents the initial display. 

2) Connect the AOC-6000 Series and a computer using the provided LAN cable (crossover cable). 

3) Configure LAN settings on the computer. 
Select [Internet Protocol Version 4 (TCP/IPv4)] from [Local Area Connection] and click [Properties]. 
Do not configure any settings for default gateway. 
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3.2 Setting the Configuration 

Make the following settings to enable controlling the AOC-6000 Series from GCMSsolution. 

 
• Be sure to set configuration settings before using the AOC-6000 Series for the first time. As long as 

the AOC-6000 Series system configuration is not changed, these settings do not need to be 
changed each time.  

1) Double-click the  (GCMS Real Time Analysis) icon on the desktop. 
The [Login] sub-window opens. 

2) Set the user ID and password, and click [OK]. 
The [GCMS Real Time Analysis] program starts up. 

 

3) Click the [System Configuration] icon on the [Real Time] assistant bar. 
The [System Configuration] sub-window opens. 
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4) Add AOC-6000 to [Modules Used for Analysis]. 
 
 

 

1 Select [AOC-6000] at [Available Modules]. 

 
AOC-6000 can be selected only when the AOC-6000 control software has been installed. 

2 Click  to add AOC-6000 to [Modules Used for Analysis].  

3 Click [Set]. 
The [System Configuration] sub-window closes. 

5) When the following message is displayed, click [OK].  

 

6) The [AOC-6000 Settings] sub-window opens. Click [Configure].  
The [PAL3 Auto Sampler] sub-window opens. 

 

1            2 

3 
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Do not change the initial [Autosampler] and [Timeout for preparation] settings. The initial settings are 
[PAL3 Auto Sampler] and [60], respectively. 
 

7) Click [Synchronize] on the [Configuration] tab page. 
The [Synchronize with instrument] sub-window opens. 

 

 
Select the [Errors and warnings] at the [Error reporting] in the [PAL3 Auto Sampler] sub-window. When 
not selected, it may cause that error and warning log is not saved correctly and data measurement 
doesn’t stop. 

8) This sub-window automatically closes when communication with the AOC-6000 Series is successfully 
finished. 
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If communication to the AOC-6000 Series cannot be established, [IP Address] may be set. Enter the IP 
address set for the AOC-6000 Series unit (see NOTE in 3.1) and click [Retry]. For the procedure to 
set/check the IP address of the AOC-6000 Series unit, refer to the PAL3 RTC/RSI User Manual. 

 
 

9) Click [OK] in the [PAL3 Auto Sampler] sub-window. 

10) Click [OK] in the [Edit AOC-6000 Config] sub-window.  

11) Confirm the AOC-6000 status in the instrument monitor.  
 

 
It takes about one minute for the status to change to [Ready].  
 

 
 

 

 

 

 

 

 
If the [Synchronize] button is clicked without switching the AOC-6000 Series power ON, an error is 
displayed in the [Synchronize with instrument] sub-window. If that occurs, follow the procedure below. 

1 Switch the AOC-6000 Series power ON. Wait until the LED on the AOC-6000 Series turns green and 
the PAL terminal presents the initial display. 

2 Click [Retry] in the [Synchronize with instrument] sub-window. 



3 Initial Setting 

 

AOC-6000 Control Software  13 

3.3 Changing the Ready Signal Setting 

If an error occurs in the GC/MS system, the GC Ready signal is controlled to prevent the AOC-6000 Series 
from injecting subsequent samples into the GC unit. 

• Open the [Acquisition] window from the [GCMS Real Time Analysis] program. 

• Select [Option] on the [Tools] menu.  

 

• Select [GC sends Ready signal after MS gets ready.] on the [Analysis Action] tab page, and click [OK].  

 

• Restart the [GCMS Real Time Analysis] program. 
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3.4 Changing the Style of Batch Tables 

To use the AOC-6000 Series for continuous data acquisition requires setting the tray names in a Batch 
Table. In default GCMSsolution settings, the column for setting tray names is not displayed. This section 
describes how to display a tray name column in a Batch Table and save the Batch Table as a template, 
then use that template for creating new batch files. 

1) Right-click on the Batch Table, and click [Table Style] on the popup menu. 
The [Table Style] sub-window opens. 

2) Selecting [Option 1] at [Hide Items] and clicking [Add >>] moves [Option 1] to [Display Items]. 

 

3) Click [Up] repeatedly to move [Option 1] to the top of the [Display Items] list. 

4) Click [OK]. 

5) To change the title for the [Option 1] column, click the [Settings] icon on the [Batch] assistant bar. 
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6) Enter "Tray" in [Option 1 Title] on the [Option Items] tab page in the [Settings] sub-window. Click [OK].  

 

7) To save this Batch Table as a template so that the template is used to create new batch files, click 
[Save Batch As Template] on the [File] menu. 

8) Enter the template file name in the [Save As Template] sub-window, and click [OK]. 

 

9) Select [Option] on the [Tools] menu. 
The [Setting Options] sub-window opens. 
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10) Select [From Template] at [Batch File] on the [File New] tab page, and click [Select]. 
The [Select Template] sub-window opens. 

 

11) Select the template file name saved at step 8), and click [OK]. 
The [Setting Options] sub-window opens again. 

  

12) Clicking [OK] returns to the Batch Table. 

With the above procedure, the column for setting the tray name is displayed when creating new batch files.  

 

 
Tray name is needed for AOC-5000 Series or AOC-6000 Series. It is not necessary to enter anything to 
the [Tray] when the other sampler is operated 
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3.5 When the AOC-6000 Series Configuration Is Changed 

3.5.1 Changing a Syringe Tool 

The AOC-6000 Series enables liquid injection, headspace injection, and solid phase micro extraction 
(SPME) injection, as well as SPME Arrow injection, and ITEX injection. Exchange the syringe tool 
depending on the injection method. 

If the type of syringe tool is changed when GCMSsolution is running, the link between the GCMSsolution 
and AOC-6000 Series must be reconnected. Exit and restart the [GCMS Real Time Analysis] program. 

 
For instructions on attaching or removing syringe tools, refer to the PAL3 RTC/RSI User Manual. 

On the AOC-6000 Series with RTC(Robotic Tool Change), syringe tools are replaced automatically. 
Replacement with a syringe tool set on the park station is done when necessary according to the syringe 
tool type specified in the method. There is no need to reconnect GCMSsolution and the AOC-6000 Series. 

 

3.5.2 Change a Tray Type 

Tray type can be changed in accordance with vial size on AOC-6000 Series PAL terminal. When a tray 
type is changed, synchronization is needed after restarting the [GCMS Real Time Analysis] program. 

1) Open the [System Configuration] sub-window. To open the [System Configuration] sub-window, see 
"3.2 Setting the Configuration." 

2) Open the [AOC-6000 Settings] sub-window from the [System Configuration] sub-window. 

 

1 Select [AOC-6000] at [Modules Used for Analysis]. 

2 Click [Properties]. 

1 
 
 
 
 
2 
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3) Click [Configure] in the [AOC-6000 Settings] sub-window. The [PAL3 Auto Sampler] sub-window 
opens. 

 

4) Click [Synchronize] on the [Configuration] tab page. 
The [Synchronize with instrument] sub-window opens. 

 

5) This sub-window automatically closes when communication with the AOC-6000 Series is successfully 
finished. 

 

6) Click [OK] in the [PAL3 Auto Sampler] sub-window. 

7) Click [OK] in the [AOC-6000 Settings] sub-window.  
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4 Method Settings 
Only users with the [Edit Method (Instrument Parameters)] system administration rights can change 
AOC-6000 method settings. 

4.1 Setting AOC-6000 Parameters 

1) Click the [Data Acquisition] icon on the [Real Time] assistant bar in the [GCMS Real Time Analysis] 
program.  
The [Acquisition] window opens. 

 

2) Click the  (Open) icon on the toolbar. 

 

3) Select the method file in the [Open Method File] sub-window, and click [Open]. 

 

4) Click [Edit] on the [Sampler] tab page in [Instrument Parameters View]. 
The [Method Parameters] sub-window opens. 
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• Only one [Method Parameters] sub-window can be opened. If it was already opened from a 

different sub-window, then that sub-window must first be closed before clicking [Edit]. 

• The [Edit] button is grayed out during data measurements and cannot be clicked.  

 

5) Set the AOC-6000 parameters. 
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No. Item Explanation 

 Apply After setting the parameters, click [Apply] to determine the settings before 
closing the sub-window. 
 

 
If you try to close the sub-window without clicking [Apply], a warning message 
is displayed. Go back to the [Method Parameters] sub-window and check the 
contents if necessary. 

 

 Print Print out the AOC-6000 parameters. 
 

 
AOC-6000 parameters cannot be printed out together with other method 
parameters. 

 Methods Select an AOC-6000 method. This software incorporates typically used 
AOC-6000 methods. 
 
Click [Methods] to display the [PAL3 Autosampler Methods] sub-window. 
Select the appropriate AOC-6000 method and click [OK]. 

 
 
If you click [] on the right of the [Methods] button, the list of available 
methods is displayed on a drop-down list. You can also select a method from 
this list. 
 
The name of the selected AOC-6000 method is displayed at the top of the 
parameter table. 

 Parameter The list of parameters of the selected AOC-6000 method is shown. 
Parameters are categorized into several groups (e.g. "Analysis" group, 
"Setup" group). The parameters in each group can be displayed and hidden 
by clicking the arrow on the left side of the group name. 
 

 
For details, see "Appendix – Method Parameters for Each Injection Method." 
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 Value 
Unit 

Set each parameter. 
Click the [Value] cell for the parameter to be set. 
Enter a value for parameters that need numerical value entry. For tools that 
are incorporated in the AOC-6000 such as syringes, select an item in the list 
box displayed. 
 

 
・ Enter a value within the range allowable for the type of the tools. 

・ Parameters with the  icons require setting. 

When the  icon is displayed, the [Apply] and [Print] buttons remain 
gray and they cannot be clicked. 
 

 
For details, see "Appendix – Method Parameters for Each Injection Method."  

 

6) Click  to close the [Method Parameters] sub-window. 

7) Select [Save Method File] on the [File] menu. 

 

 
 

• Methods can also be created in the [Acquisition] sub-window in the [GCMS Analysis Editor] 
program. 

• The computer must be connected to the AOC-6000 Series unit to specify AOC-6000 methods. 
Methods cannot be created on other computers using a secondary license program. 
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4.2 Printing AOC-6000 Parameters 

4.2.1 Printing from the [GCMS Real Time Analysis] Program 

1) Open the method file in the [Acquisition] window.  

2) Click [Edit] on the [Sampler] tab page in [Method Parameters]. 
The [Method Parameters] sub-window opens. 

 

3) Click [Print]. 
The [Print Preview] sub-window opens. 

 



4 Method Settings 

24  AOC-6000 Control Software 

4) Check [Page Setup] and click [Print] to print the parameter list. 

 
 

 

 

4.2.2 Printing from the [GCMS Postrun Analysis] Program 

1) Open the data file in the [Data Analysis] window. 

2) Select [Data Acquisition Settings] on the [View] menu, and click [Instrument Parameters]. 
The [Data Acquisition Parameters] sub-window opens. 
 

3) Click [Edit] on the [Sampler] tab page. 
The [Print Preview] sub-window opens. 

 
AOC-6000 parameters can't be printed together with GC/MS instrument parameters. 
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4) Click [Print]. 

 

 

 

 

 

 
AOC-6000 parameters can’t be printed together with GC/MS instrument parameters. 
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5 Measuring Samples 

1) Click the  (Open) icon on the toolbar in the [Acquisition] window. Select the method file to use in 
the [Open Method File] sub-window, and click [Open]. 

 
 

 
Confirm that the type of syringe tool attached to the AOC-6000 Series matches the syringe size setting 
for [Syringe Tool] in AOC-6000 parameters in the specified method file. See "4.1 Setting AOC-6000 
Parameters" to confirm AOC-6000 parameters. 

2) Click the [Sample Login] icon on the [Acquisition] assistant bar. 
The [Sample Login] sub-window opens. 
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3) Click [AOC-6000 Settings]. 
The [AOC-6000 Settings] sub-window opens. 

 

4) In [Tray], select the name of the tray where vials will be placed. If the appropriate tray name is not 
listed in the drop-down list, enter the name directly. This setting is case-sensitive. Enter a space 
between “Rack” and the number. 
Click [OK] to go back to the [Sample Login] sub-window again. 

 

 
 Specify the tray name which has been set on the AOC-6000 Series unit. Default settings are as 
follows. 

Rack: Rack 1, Rack 2, Rack 3, ……. 
 The specified tray name is recorded in the data file. Load the data on the [GCMS Postrun 

Analysis] program, select [Data File Properties] from the [File] menu, and check the tray name 
on the [Option Info.] tab page 

5) Enter the data file name, vial number, injection volume, and other settings, then click [OK]. 
The [Acquisition] window opens again. 
 

 
• Vial numbers cannot be set to 0 or -1. 

• Injection volume settings are in terms of L units. If a headspace syringe tool is used, use caution 
specifying the injection volume. Set an injection volume of 1 for SPME syringe tools or SPME 
Arrow syringe tools. 

• Enter vial number and injection volume values that are within a normal range. 
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6) Arrange the specified vials in the tray.  
 

 

• Be careful not to forget placing the vials.  

• If any vials are remaining in the agitator, they must be removed.  

• If an error occurs during data acquisition, the analytical process is stopped. 

7) Click the [Standby] icon on the [Acquisition] assistant bar. 
When the GC and MS units are restored to ready state, data acquisition starts automatically. 

 

 

 
Vials left in the agitator will cause an error the next time data is acquired. Remove vials manually. 
 

 
The agitator can become very hot. Therefore, be very careful not to get burned when removing the 
vials. 
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6 Measuring a Series of Samples 
Continuously 

1) Click the [Batch Processing] icon on the [Real Time] assistant bar in the [GCMS Real Time Analysis] 
program. 
The [Batch Table] window opens. 

 

2) Select [New Batch File] on the [File] menu. 

 

3) Enter the sample type, method file name, data file name, vial number, injection volume, and other 
information. 
 

 
• Confirm that the type of syringe tool attached to the AOC-6000 Series matches the syringe size 

setting for [Syringe Tool] in AOC-6000 parameters in the specified method file. See "4.1 Setting 
AOC-6000 Parameters" to confirm AOC-6000 parameters. 

• Note the following precautions regarding vial numbers and injection volume values. 

- Injection volume settings are in terms of L units. If a headspace syringe tool is used, use 
caution specifying the injection volume. Set an injection volume of 1 for SPME syringe tools 
or SPME arrow syringe tools. 

- If a headspace syringe tool or ITEX syringe tool is used, specify the same injection volume 
values in a batch file. To use a combination of different injection volumes, use a batch queue. 

- Vial numbers cannot be set to 0 or -1. 

• Specify method files that contain the identical AOC-6000 parameters and the identical initial 
GC/MS temperature like injection unit when using headspace, SPME, SPME arrow and ITEX 
syringe tool. Different parameters could cause an error to occur during batch processing and stop 
measurements. To use different parameters, use a batch queue. 
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4) Set the rack name by entering "Rack 1" if using rack 1 and "Rack 2" if using rack 2. Enter a space 
between “Rack” and the number. This setting is case-sensitive. Make sure it is set correctly. 

 

  
 Specify the tray name which has been set on the AOC-6000 Series unit. Default settings are as 
follows. 

Rack: Rack 1, Rack 2, Rack 3, ……. 
 The specified tray name is recorded in the data file. Load the data on the [GCMS Postrun 

Analysis] program, select [Data File Properties] from the [File] menu, and check the tray name 
on the [Option Info.] tab page 

5) Select [Save Batch File As] on the [File] menu. 

 

6) Navigate to the desired folder for saving the batch file, then enter the file name and click [Save]. 

 

7) Arrange the specified vials in the tray. 
 

 
• Be careful not to forget placing the vials. 
• If any vials are remaining in the agitator, they must be removed.  
• If an error occurs during data acquisition, the analytical process is stopped. 
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8) Click the [Start] icon on the [Batch] assistant bar to start batch processing. 

 
 

 
 

 

 
• Note the following precautions to stop or pause batch processing. 

- To stop batch processing, click the [Stop] icon on the [Batch] assistant bar. If a batch is stopped, 
samples in the agitator are not injected. 

- If any vials remain in the agitator, an error occurs when analysis is started the next time. If there 
are any remaining vials, manually remove them. 

- When a method file that specifies an AOC-6000 method for headspace, SPME, SPME arrow or 
ITEX is used, then the batch process cannot be paused.  

• When a method file or AOC-6000 has an issue like no vial or wrong syringe adapter, an error 
message is displayed and batch processing is stopped. When vials are left in agitator, remove them. 

• Don’t open the method file used in ongoing batch processing in the [GCMS Analysis Editor] program 
and the [Calibration Curve] window of the [GCMS Postrun Analysis] program. It may cause an error 
and the batch processing stopped. 

 

 
The agitator can become very hot. Therefore, be very careful not to get burned when removing the 
vials. 

 
• When headspace, SPME, SPME arrow or ITEX syringe are used, the following vials are incubated 

during data acquisition (overlapped incubation).  

• In batch processing, data acquisition can be performed on up to 60 samples at one time. To perform 
data acquisition on more samples, create a new batch file and run data acquisition using a batch 
queue. 

• On the AOC-6000 Series with RTC (Robotic Tool Change), syringes are replaced automatically. 
However, on a batch file, use one syringe for data acquisition. For example, to establish a 
TwinLineMS system and perform batch processing while switching between headspace and SPME, 
create a batch file each for headspace and SPME, register one of them to a batch queue, and run 
data acquisition. 
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7 Advanced Operations 

7.1 Confirming the Tray Name 

Display the tray names registered in the AOC-6000 Series. During measurements, the specified tray 
names must be the same as names displayed here. 

1) Open the [System Configuration] sub-window. To open the [System Configuration] sub-window, see 
"3.2 Setting the Configuration." 

2) Open the [AOC-6000 Settings] sub-window from the [System Configuration] sub-window. 

 

1 Select [AOC-6000] at [Modules Used for Analysis]. 

2 Click [Properties]. 

3) Click [Configure] in the [AOC-6000 Settings] sub-window. The [PAL3 Auto Sampler] sub-window 
opens. 

 

1 
 
 
 
 
2 
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4) Click [Bed Layout] in the [PAL3 Auto Sampler] sub-window. 

 
 
The tray names registered in the AOC-6000 are displayed. 
 
 
 

 

 

No. Item Explanation 

 # Displays the tray numbers. 

 Name Displays the names of the trays. These character strings are used for tray 
name set during measurements  

 Plate Displays the type of tray attached to the tray holder.  

 Holder Displays the names of the tray holders.  

 

 

 



7 Advanced Operations 

34  AOC-6000 Control Software 

7.2 Confirming the Location Where AOC-6000 Methods Are Saved 

1) Open the [System Configuration] sub-window. To open the [System Configuration] sub-window, see 
"3.2 Setting the Configuration." 

2) Open the [AOC-6000 Settings] sub-window from the [System Configuration] sub-window. 

 

1 Select [AOC-6000] at [Modules Used for Analysis]. 

2 Click [Properties]. 

3) Click [Configure] in the [AOC-6000 Settings] sub-window. The [PAL3 Auto Sampler] sub-window 
opens. 

 

1 
 
 
 
 
2 
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4) Click [Go to Data Location] on the [Configuration] tab page in the [PAL3 Auto Sampler] sub-window. 
The default folder where AOC-6000 methods should be saved is opened in Windows Explorer. 
 

 

7.3 Protecting Method Files and AOC-6000 Methods 

To ensure method files and AOC-6000 methods can be used in a safe environment, use GCMSsolution 
system administration to specify appropriate operating policies and manage users. This software enables 
using GCMSsolution functionality to do the following. For more details, refer to the GCMSsolution 
Instruction Manual or the [Help] menu. 

● System administration [Edit Method (Instrument Parameters)] rights can restrict users from 
changing method files. 
This prevents unauthorized users from make accidental changes. 

● If the audit trail function is enabled, any changes made to methods files can be verified. If an 
AOC-6000 parameter is changed, the method file audit trail saves a record of the fact that a change 
was made. However, it does not record how individual parameters were changed. 

To prevent accidental changes to AOC-6000 method, assign that right to the user that logs into Windows, 
so that only specified users can change the file. Refer to the Windows [Help] menu or other sources 
regarding how to set user rights. However, note the following precautions. 

● For instructions on how to open the folder, see "7.2 Confirming the Location Where AOC-6000 
Methods Are Saved." 

● The names of files and folders that should have restricted access are indicated below. 

Folder/File Name Type User/Group Right (for example) 

Shimadzu Folder [Delete subfolders and files], [Delete] and [Change 
permissions] are not allowed. 

Shimadzu\InstrumentControl Folder [Delete subfolders and files], [Delete] and [Change 
permissions] are not allowed. 

Shimadzu\*** 
(Folder other than 
InstrumentControl) 

Folder Full control 

Shimadzu\InstrumentControl\ Folder [Delete subfolders and files], [Delete] and [Change 
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PAL3 permissions] are not allowed.  

Shimadzu\InstrumentControl\
PAL3\Scripts  

Folder [Delete subfolders and files], [Delete] and [Change 
permissions] are not allowed.  

Shimadzu\InstrumentControl\
PAL3\***.*** 

File Full control 

Shimadzu\InstrumentControl\
PAL3\Scripts\***.xml 

File [Create files / write data], [Delete] and [Change 
permissions] are not allowed.  

7.4 Checking Programs 

The following enables checking that a program was installed correctly. 

1) Start up the Windows Explorer. 

2) Double-click the [Check the Program Files] program (ShimadzuMD5Check.exe). 
The [Check the Program Files] program is in the following location. 
32-bit PC C:\Program Files\Shimadzu\InstrumentControlSolution\ShimadzuMD5Check.exe 
64-bit PC C:\Program Files (x86)\Shimadzu\InstrumentControlSolution\ShimadzuMD5Check.exe 

3) Click [Check Program Files].  
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4) If the programs have been installed correctly, "passed" is displayed for all programs.  
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8 Troubleshooting 

8.1 Connection to the AOC-6000 Series Failed 

When the [GCMS Real Time Analysis] program is started, the AOC-6000 Series status remains [Not 
Connected] in the instrument monitor. 

Error Message Probable Cause Corrective Measure 

None Connection to the AOC-6000 

Series is taking a long time. 

Wait for a while. It takes about 1 

minute for the status to change to 

[Ready] after starting the [GCMS Real 

Time Analysis] program. 

Error has occurred in 

instruments. 

(The Driver is currently not 

connected) 

 

The communication cable is 

disconnected between the 

AOC-6000 Series and 

computer.  

Make sure the communication cable is 

connected properly.  

The AOC-6000 Series power is 

OFF. 

Switch the AOC-6000 Series power 

ON and wait for AOC-6000 Series 

initialization to finish before starting 

the [GCMS Real Time Analysis] 

program. 

Multiple instances of the 

program were launched 

internally.  

Restart the computer. 

An incorrect IP address is set. Check the IP address of the 

instrument and computer. 

Error has occurred in 

instruments.  

(There is already a listener on 

IP endpoint 127.0.0.1:64001. 

Make sure that you are not 

trying to use this endpoint 

multiple times in your 

application and that there are 

no other applications listening 

on this endpoint.) 

The AOC-6000 Series and 

computer  could not be 

connected when the [GCMS 

Real Time Analysis] program 

was started. 

Exit the [GCMS Real Time Analysis] 

program, wait for approximately ten 

seconds, and restart the program. 

 

8.2 Data Acquisition Does Not Start 

An error occurs if data acquisition is started. 

Error Message Probable Cause Corrective Measure 

Cannot stand by 

（Invalid injection volume.） 

Appropriate injection volume is 

not specified.  

Specify an injection volume (L) 

consistent with the syringe tool setting 

in the method. 
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Error Message Probable Cause Corrective Measure 

Appropriate AOC-6000 Series 

syringe tool is not specified in 

method.  

In methods, specify the syringe tool 

actually installed on the instrument. 

The value specified in method 

parameters is outside the 

specified range.  

See "Method Parameters for Each 

Injection Method " and enter a [Value] 

setting that is within the input range 

specified for the instrument 

Cannot stand by 

（Incorrect tray number） 

 

The tray name specified for the 

tray is not correct.  

Specify the correct tray name. Tray 

names are case-sensitive. 

● For continuous data acquisition, 

confirm the Option 1 (Tray) setting 

for the batch file. 

● For data acquisition analyses, 

confirm the tray name registered in 

sample registration. 

Synchronization was not 

performed.  

Synchronization is required 

before initial use after changing 

tray information in the 

AOC-6000 Series unit or after 

installation.  

Click the [Configure] button in the 

AOC-6000 properties ([Edit AOC-6000  

Config]) in the [System Configuration] 

sub-window, and click the 

[Synchronize] button in the window 

that is displayed. 

Error has occurred in 

instruments.  

(Number of samples exceeds 

the upper limit. This system 

allows up to 60 samples.) 

The number of samples 

registered to the batch file is 

over the upper limit. This 

system can perform data 

acquisition on up to 

60 samples. 

Limit the number of samples 

registered to the batch file to 60 at the 

maximum. To measure more samples, 

create a new batch file for them and 

register the file to a batch queue. 

Error has occurred in 

instruments.  

(Cannot aspirate requested 

volume. Total volume exceeds 

syringe volume. Requested: X 

μL; Currently available) 

The aspiration volume is over 

the allowable volume for the 

syringe. 

Reduce the aspiration volume for the 

wash solvent, internal standard, and 

pumping in the AOC-6000 method. Or, 

reduce the injection volume during 

data acquisition. 

The value set for the internal 

standard penetration depth is 

too small. 

Set a larger value for the internal 

standard penetration depth in the 

AOC-6000 method. 

Error has occurred in 

instruments.  

(Cannot change the Tool. 

There is no free Slot in any 

configured Tool Change 

Station.) 

The syringe tool cannot be 

changed because the park 

station has no free slot. 

Remove unnecessary syringe tools 

from the park station. 

Error has occurred in 

instruments.  

(Cannot move to target Vial 

with current needle guide 

type) 

The vial cannot be moved 

because of incorrect needle 

guide type setting in tool 

setting on the AOC-6000 

Series. 

Set the needle guide type on the 

AOC-6000 Series correctly according 

to the size of the vial used and the cap 

type. 
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Error Message Probable Cause Corrective Measure 

Error has occurred in 

instruments. 

(Cannot transport the vial. Vial 

and destination is 

incompatible. Check the 

configuration.) 

The type of vial in the agitator 

is different from the vial 

actually used. 

Specify the type of the vial set on the 

rack for the type of vial in the agitator 

on the AOC-6000 Series unit. 

Error has occurred in 

instruments.  

(Collision occurred on 'Plunger 

Drive 1' (force limit exceeded)) 

A collision was detected during 

operation of the syringe 

plunger. 

Remove the foreign object. 

One batch file is being used for 

data acquisition using different 

syringes. 

Use the same syringe for one batch 

file. To perform data acquisition with 

switching syringes, create a batch file 

for each syringe, register one of them 

to a batch queue, and run data 

acquisition. 

Error has occurred in 

instruments.  

(Collision occurred on 'Z Drive 

X' (force limit exceeded).) 

Data acquisition was started 

with a vial remaining in the 

agitator. 

Remove vials from the agitator. Also, 

remove any vials from the injection tool 

(PAL head). 

The syringe tool collided with a 

vial placed behind the specified 

vial. This error occurs, for 

example, when a rack for 

20 mL vials is placed behind a 

rack for 2 mL vials. 

Place a rack for tall vials in the front. 

Tray type is wrong. Set correct tray type in PAL terminal 

on AOC-6000 Series. Then conduct 

synchronization. 

Click the [Configure] button in the 

AOC-6000 properties ([Edit AOC-6000  

Config]) in the [System Configuration] 

sub-window, and click the 

[Synchronize] button in the window 

that is displayed. 

Interference occurred between 

a vial and another vial placed 

on the rack when the vial was 

returning to the rack from the 

agitator or other part. 

Remove both vials that interfered. 
Check for problems in vial or rack 
settings and teaching. 

If the injection unit (PAL head) did not 

go back to its home position, shut 

down the AOC-6000 Series and restart 

it. 

For the shutdown procedures, refer to 

the PAL3 RTC/RSI User Manual. 

Error has occurred in 

instruments.  

(Error: Error while validating 

script.) 

The AOC-6000 method 

settings or the AOC-6000 unit 

settings are insufficient or 

incorrect. 

Check the AOC-6000 method settings 

or the AOC-6000 unit settings. 

Error has occurred in 

instruments.  

(LS X has not been calibrated 

with RobotArmLeft yet.) 

The LS X tool position has not 

been calibrated. 

Calibrate the LS X tool position from 

the PAL terminal. 
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Error Message Probable Cause Corrective Measure 

Error has occurred in 

instruments. 

(Rack item type of Rack X is 

not set.) 

There is not sufficient 

information about the rack 

used on the AOC-6000. 

Specify the rack item for the rack to be 

used on the AOC-6000 Series. 

Error has occurred in 

instruments.  

(Requested penetration depth 

X (incl. position above the 

target) is >= Maximum tool 

penetration depth Y) 

The penetration depth is over 

the allowable amount for the 

syringe. 

Set a smaller penetration depth value 

in the AOC-6000 method. 

Error has occurred in 

instruments.  

(Specified Flow Rate exceeds 

maximum allowed plunger 

speed.) 

The sample aspiration/injection 

speed is over the allowable 

rate for the syringe. 

Set a smaller flow rate value in the 

AOC-6000 method. 

Error has occurred in 

instruments.  

(Target Object Injector X, 

Index X could be detected but 

it was outside the allowed 

range.) 

The injector's injection position 

is incorrect. The adapter may 

not be placed on the GC 

injection unit. 

Place the adapter on the GC injection 

unit. If it has been already placed, 

perform teaching for the injector's 

injection position again. 

Error has occurred in 

instruments. 

(Target Object PosX, Index X 

could not be detected.) 

Vials such as wash vial, 

internal standard vial, and 

waste solution vial are not 

detected. 

 

Place the vials at the specified 

positions. 

Error has occurred in 

instruments.  

(Target vial could not be 

detected. This might be 

caused by a missing or a 

wrong vial.) 

 

Vials were not placed in the 

rack. 

Place vials in the specified rack. 

An incorrect rack type is 

specified. 

Register the correct rack for the vial 

size on the AOC-6000 Series unit. 

The vial moves unintentionally 

because no use of magnetism 

is specified for a vial cap that 

uses magnetism. 

For a vial cap that uses magnetism, 

select "Magnetic" in rack item setting 

for the rack on the AOC-6000 Series 

unit. 

The specified tray name is 

incorrect. 

Specify the name of the tray where 

vials were actually placed. 

● For continuous data acquisition, 

confirm the Option 1 (Tray) setting 

for the batch file. 

● For data acquisition analyses, 

confirm the tray name registered in 

Sample Login. 

The rack position is not set 

correctly. 

Perform teaching for the rack position 

again. 

Error has occurred in 

instruments. (Unable to use 

PAL method) 

There is no syringe tool to be 

used. 

Attach a syringe tool to be used or 

place it in the park station. 

Then, run [Synchronize] in the [GCMS 

Real Time Analysis] program. 
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Error Message Probable Cause Corrective Measure 

Error has occurred in 

instruments.  

(X Drive 1 is not homed.) 

The injection unit (PAL Head) 

has been returned to its home 

position. 

Turn OFF and then ON the AOC-6000 

Series. If the error still occurs, turn 

OFF the power and then manually 

move the injection unit to its home 

position. 

Error has occurred in 

instruments. 

(General_SmartObjectStatus

Defect) 

The status of the Smart Syringe 

attached to the head of the 

AOC-6000 Plus or that of the 

SPME fiber or SPME Arrow is 

"Defective". 

Perform replacement with a new 

Smart Syringe, SPME fiber, or SPME 

Arrow. 

Change the status to "OK" or 

"Suspect" at the PAL terminal. 

Error has occurred in 

instruments. 

(Smart Object Plunger not 

present) 

The plunger of the Smart 

Syringe is broken. 

Replace with a new Smart Syringe. 

If GCMSsolution is unintentionally closed, be sure to restart the computer. Otherwise, the AOC-6000 
Series cannot be controlled correctly. 

If the injection unit (PAL head) does not go back to its home position after an error occurs, shut down the 

AOC-6000 Series first and restart it. 

For the shutdown procedures, refer to the PAL3 RTC/RSI User Manual. 
 

8.3 AOC-6000 Series Status Remains [Run] 

If the automatic recovery function of the AOC -6000 Series does not work due to an unexpected error 
during the analysis (for example, the AOC -6000 Series status remains [Run]), restart the computer.
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Appendix – Method Parameters for 
Each Injection Method 
The following describes the parameters and reference values used in methods for each injection method. 
Since the optimal parameter values vary depending on the type and quantity of sample, optimize parameter 
values by eventually measuring samples. 

 
• In methods for which the temperature of the sample can be maintained during data measurement 

including headspace methods, injection operation does not start until the state of the GC unit becomes 
Ready. Therefore, set the [Analysis Time ] parameter value that allows plenty of time. 

  

 
• From AOC-6000 Control Software Ver.2.0, the default values of the method parameters of Liquid 

Injection, Headspace Injection and SPME Arrow Injection have been changed. For details, see NOTE for 
each method parameter.  

  

 
• In AOC-6000 control software Ver. 2.1 and later, the upper settings limit for the heating temperature of a 

sample vial with an agitator is restricted to 80 C. This ensures that the internal vial pressure does not 
become too high when a low boiling point solvent such as hexane is used as the sample solvent. Use a 

method for high boiling point solvents if heating the vial higher than 80 C. In a method for high boiling 

point solvents, the temperature can be set up to 200 C. However, please set the temperature to a 

maximum of the solvent boiling point +10 C. 
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AOC-6000 Method List 

The following methods are available for use when the AOC-6000 control software is installed. 

Method Name Application Syringe 
(example) 

Details 

Liquid Injection For liquid injection 
methods 

10L A syringe for injecting liquids is used to 
inject samples. 

SPME Injection For SPME methods Fiber Samples adsorbed to SPME fiber are 
injected.  
Samples are adsorbed by heating 
reagents in an agitator while stirring. After 
injecting samples, fibers are conditioned 
in a bakeout station. 

(For High Boiling Solvent) 

SPME Injection For High 

Boiling Solvent 

Headspace Injection For headspace 
methods 

2.5mL-HS A headspace syringe is used to inject 
samples. (For High Boiling Solvent) 

Headspace Injection For 

High Boiling Solvent 

SPME Arrow Injection For SPME Arrow 
methods 

Arrow Samples adsorbed to SPME arrow are 
injected. 

After the reagent is heated while being 
stirred by the agitator, samples are 
adsorbed while being agitated by the 
Heatex Stirrer. After injecting samples, 
fibers are conditioned in a bakeout 
station. 

(For High Boiling Solvent) 

SPME Arrow Injection For 

High Boiling Solvent 

ITEX Injection For ITEX DHS 
methods 

ITEX The reagent is heated while being 
stirred by the agitator. The headspace 
portion is pumped multiple times, and 
samples are adsorbed by the adsorbent 
inside the syringe. 

(For High Boiling Solvent) 

ITEX Injection For High 

Boiling Solvent 

 

Parameter Groups 

Parameters of methods are categorized into the following groups. 

Group Name Description 

Analysis Parameters in this group need to be set to appropriate values according to the target 
sample to be measured. 

Setup Parameters in this group are determined by the selection of instrument configuration 
or the instrument selected. When selected the new method, be sure to specify 
instrument configuration first. They rarely need to be changed once they have been 
set. 

Advanced Parameters in this group are expanded parameters. Basically keep the initial values 
and only change them when necessary. 

 

 

• When the [Method Parameters] sub-window is opened, parameters in the [Setup] group and 
[Advanced] group are hidden. Click the arrow on the left side of the group name to display the 
parameters. 
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Method Parameters for Liquid Injection Methods 

Parameter Name  Description Default Settable Range Remarks 

Analysis Group 

Syringe Tool Specifies the 
syringe tool for 
liquid injection. 

  Select one from the list 
of syringe tools for 
injection connected to 
the instrument (e.g. 
LS1, LS2). 

Pre Wash Cycles Number of cycles to 
wash the syringe 
before sampling 

3 0-15  

Sample Rinse 
Cycles 

Number of cycles to 
rinse with the 
sample before 
sampling 

1 0-10  

Sample Aspirate 
Flow Rate 

Speed to take up 
the sample to be 
injected 

1uL/s 0.1-100uL/s  

Sample Post 
Aspirate Delay 

Waiting time from 
when the sample to 
be injected is 
collected until the 
syringe is pulled out 
from the sample 
vial 

2s 0-10s  

Injector Specifies the 
injector name. 

  Select one from the list 
of the injectors 
connected to the 
instrument (e.g. 
Injector1, Injector2). 

Injection Flow 
Rate 

Speed to inject the 
sample 

50uL/min 1-250uL/min  

Post Wash Cycles Number of cycles to 
wash the syringe 
after sample 
injection 

3 0-15  

Setup Group 

Gas 
Chromatograph 

Specifies the GC 
unit to be used. 

  Select one from the list 
of GC units connected 
to the instrument 
(e.g. GC1). 

Cooled Stack 1 Specifies this item 
only when using the 
cooled stack. 

  Select one from the 
pull-down list. 

Cooled Stack 1 
Temperature 

Temperature of 
cooled stack 1 

20C 4-40C  

Cooled Stack 2 Specifies this item 
only when using the 
cooled stack. 

  Select one from the 
pull-down list. 
 

Cooled Stack 2 
Temperature 

Temperature of 
cooled stack 2 

20C 4-40C  

Pre Wash Station Specifies the wash 
station to be used 
to wash the syringe 
before sampling. 

  Select one from the list 
of wash stations 
connected to the 
instrument. 

Post Wash Station Specifies the wash   Select one from the list 
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Parameter Name  Description Default Settable Range Remarks 

station to be used 
to wash the syringe 
after sampling. 

of wash stations 
connected to the 
instrument. 

Wash Vial Depth Depth to insert the 
syringe into the 
wash solution bottle 

40mm 20-73mm See Note 3. 

Waste Port Depth Depth to insert the 
syringe into the 
waste solution 
bottle 

10mm 10-45mm See Note 3. 

Sample Vial Depth Depth to insert the 
syringe into the 
sample vial 

30mm 1-45mm  

Bottom Sense 
Sample Vial 

Specifies whether 
or not to use the 
bottom sensing 
function when the 
syringe is inserted 
into the sample vial. 

Off On 

Off 
This parameter is only 
used in the AOC-6000 
with RTC(Robotic Tool 
Change). In the other 
model, please use the 
initial value(Off), Not to 
damage the syringe. 

Height From 
Bottom Sample 
Vial 

Depth to insert the 
syringe into the 
sample vial (height 
from the bottom) 

3mm 0-32mm  

Injection Mode Injection mode of 
the GC unit 

Normal Normal 
Fast 

When "Fast" is 
selected, injection is 
performed at the 
maximum registered 
value. 

Injection Signal 
Mode 

Timing to send the 
Start signal 

PlungerDown 

 
PreInject 
PlungerUp 

PlungerDown 

None 

PreInject: 
Before the syringe is 
inserted into the 
injector 

PlungerUp: 
When the syringe is 
pulled out from the 
injector 

PlungerDown: 
When the plunger is 
pressed down and the 
sample is injected 

None: 

The Start signal is not 
output. 

Injector 
Penetration Depth 

Depth to insert the 
syringe into the 
injector 

40mm 10-73mm  

Pre Ahead Option Specifies the timing 
to wait for the GC 
Ready signal. 

Disabled Disabled 

 

After sample rinse 

 

After bubble 
elimination 

 

After sample asp. 
In home 

Disabled: 
Standby before 
washing the syringe 
which is performed 
before sampling 

After sample rinse: 
Standby after sample 
rinse (before pumping 
the sample in and out) 
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Parameter Name  Description Default Settable Range Remarks 

After bubble 
elimination: 
Standby after 
pumping the sample 
in and out (before 
sampling) 

After sample asp. In 
home: 
Standby after 
sampling (before 
injection to GC) 

Advanced Group 

Pre Wash Solvent 
Volume 

Volume of the wash 
solvent used for 
washing the syringe 
before sampling 

8uL 0.1-1000uL  

Pre Wash Solvent 
Position Step 1 

Index of the pre 
wash station used 
for the first wash 

1 0-4 Set "0" when not using 
the wash solvent. 

Pre Wash Solvent 
Position Step 2 

Index of the pre 
wash station used 
for the second 
wash 

0 0-4 Set "0" when not using 
the wash solvent. 

Pre Wash Solvent 
Position Step 3 

Index of the pre 
wash station used 
for the third wash 

0 0-4 Set "0" when not using 
the wash solvent. 

Pre Wash Solvent 
Position Step 4 

Index of the pre 
wash station used 
for the fourth wash 

0 0-4 Set "0" when not using 
the wash solvent. 

Pre Wash Aspirate 
Flow Rate 

Speed to collect the 
wash solvent for 
washing the syringe 
before sampling 

1uL/s 0.1-100uL/s  

Sample Vial 
Penetration Speed 

Speed to insert the 
syringe into the 
sample vial 

50mm/s 1-75mm/s  

Sample Rinse 
Volume 

Volume of the 
solvent used for 
rinsing with the 
sample before 
sampling 

3uL 0-1000uL  

Filling Strokes 
Count 

Number of cycles to 
pump the sample in 
and out when 
sampling 

5 0-15  

Filling Strokes 
Volume 

Volume of the 
sample to be 
pumped in and out 
when sampling 

3uL 0-1000uL  

Filling Strokes 
Aspirate Flow Rate 

Speed to take up 
the sample by 
pumping the 
sample in and out 
when sampling 

5uL/s 2-100uL/s See Note 2. 

Filling Strokes 
Post Aspirate 
Delay 

Waiting time from 
when the sample is 
taken up until it is 

0.2s 0-10s  
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Parameter Name  Description Default Settable Range Remarks 

discharged by 
pumping the 
sample in and out 
when sampling 

Filling Strokes 
Post Dispense 
Delay 

Waiting time from 
when the sample is 
discharged until it is 
taken up next time 
by pumping the 
sample in and out 
when sampling 

0.5s 0-10s  

Delay After Filling 
Strokes 

Waiting time after 
pumping the 
sample in and out 
until the sample for 
injection is 
collected 

0.5s 0-10s  

Air Gap Volume Volume of the air to 
be taken up after 
sampling. 

1uL 0-1000uL  

Injector 
Penetration Speed 

Speed to insert the 
syringe into the 
injector 

100mm/s 2-200mm/s  

Pre Injection Dwell 
Time 

Waiting time from 
when the syringe is 
inserted into the 
injector until the 
sample is injected 

0s 0-15s  

Post Injection 
Dwell Time 

Waiting time from 
when the sample is 
injected until the 
syringe is pulled out 

0.3s 0-15s  

Post Wash Solvent 
Volume 

Volume of the wash 
solvent collected for 
washing the syringe 
after sample 
injection 

8uL 0.1-1000uL  

Post Wash Solvent 
Position Step 1 

Index of the post 
wash station used 
for the first wash 

1 0-4 Set "0" when not using 
the wash solvent. 

Post Wash Solvent 
Position Step 2 

Index of the post 
wash station used 
for the second 
wash 

0 0-4 Set "0" when not using 
the wash solvent. 

Post Wash Solvent 
Position Step 3 

Index of the post 
wash station used 
for the third wash 

0 0-4 Set "0" when not using 
the wash solvent. 

Post Wash Solvent 
Position Step 4 

Index of the post 
wash station used 
for the fourth wash 

0 0-4 Set "0" when not using 
the wash solvent. 

Post Wash 
Aspirate Flow Rate 

Speed to collect the 
wash solvent for 
washing the syringe 
after the sample 
injection 

1uL/s 0.1-100uL/s  
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1. When changing the syringe tool to a tool with a different syringe size, change the corresponding 

parameters ([Volume], [Flow Rate]) settings to appropriate values. 

2. When performing liquid injection with a gas-tight syringe (syringe with a plunger tip), change the 
value of [Filling Stroke Aspirate Flow Rate] from 5 uL/s to 2 uL/s. This changes the settings so that 
the sample is suctioned slowly, to prevent bubbles forming inside the syringe. 

3. If a metal plate for fastening the vials is attached to the standard wash module, change the value of 
[Wash Vial Depth] from 40 mm to 44 mm, and change the value of [Waste Port Depth] from 10 mm 
to 20 mm. 

4. Since AOC-6000 Control Software Ver.2.0, the default values of the following method parameters 
of Liquid Injection have been changed. Please be careful when upgrading from your software 
version 2.0 or earlier. 

Group Parameter Name Default 

Ver.2.0 or later ~ Ver.1.3 

Analysis Injection Flow Rate 50uL/s 100uL/s 

Advanced Pre Wash Aspirate Flow Rate 1uL/s 5uL/s 

Sample Rinse Volume 3uL 6uL 

Filling Strokes Volume 3uL 6uL 

Air Gap Volume 1uL 0uL 

Post Wash Aspirate Flow Rate 1uL/s 5uL/s 
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Method Parameters for Headspace Methods 

Parameter Name  Description Default Settable 
Range 

Remarks 

Analysis Group 

Syringe Tool Specifies the name of the 
syringe tool for HS 

  Select one from the 
list of syringe tools 
for HS connected to 
the instrument (e.g. 
HS1, HS2). 

Incubation 
Temperature 

Incubation temperature 
for sample vials in the 
agitator  
 

80C (Headspace 
Injection 
Method) 

30-80C 

 

(Headspace 
Injection For 
High Boiling 
Solvent 
Method) 

30-200C 

Incubation Time Time to incubate sample 
vials in the agitator 

45min 0.1-600min  

Syringe 
Temperature 

Temperature to heat the 
syringe 

100C (Headspace 
Injection 
Method) 

40-100C 

To prevent 
deterioration of the 
syringe, set the 
syringe temperature 
at about 30°C at the 
PAL terminal except 
during analysis. 

(Headspace 
Injection For 
High Boiling 
Solvent 
Method) 

40-150C 

Agitator Speed Agitator’s rotating speed 250rpm 250-750rpm  

Pre Purge Time Time of syringe purge 
performed before 
sampling  

0s 0-60s  

Injector Specifies the injector 
name. 

  Select one from the 
list of the injectors 
connected to the 
instrument (e.g. 
Injector1, Injector2). 

Injection Flow Rate Speed of sample injection 25mL/min 1-100mL/min  

Post Purge Time Time of syringe purge 
performed after sample 
injection 

60s 0-600s  

Analysis Time Interval to repeat analysis 15min 0-600min The time is the total 
of the GC program 
time, cooling time, 
equilibration time, 
plus some additional 
time. 

Setup Group 

Gas Chromatograph Specifies the GC unit to 
be used. 

  Select one from the 
list of GC units 
connected to the 
instrument (e.g. 
GC1). 
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Parameter Name  Description Default Settable 
Range 

Remarks 

Sync Before 
Incubation End Time 

Specifies the time to start 
the Cryo Trap operation 
by using the time before 
sample vial incubation 
ends. 

0min 0-600min Use this parameter 
when Cryo Trap is 
installed on the GC 
unit. 
Set "0 min" when 
Cryo Trap is not 
used. 

Agitator Specifies the agitator.   Select one from the 
list of trays 
connected to the 
instrument. 

Do Agitation Specifies whether or not 
to vibrate (rotate) the 
agitator. 

True True 

False 
 

Heat Agitator Specifies whether or not 
to heat the agitator. 

True True 

False 
 

Wait For Readiness 
Agitator 

Specifies whether or not 
to wait until the actual 
temperature reaches the 
set value when setting 
the temperature of the 
agitator. 

True True 

False 
 

Sample Vial Depth Depth to insert the 
syringe into the sample 
vial 

15mm 10-50mm  

Heat Syringe Specifies whether or not 
to heat the headspace 
syringe. 

True True 

False 
 

Wait For Readiness 
Syringe 

Specifies whether or not 
to wait until the actual 
temperature reaches the 
set value when setting 
the temperature of the 
headspace syringe.  

True True 

False 
 

Injection Signal 
Mode 

Timing to send the Start 
signal 
 

PlungerUp PreInject 
PlungerUp 

PreInject： 

Before the syringe is 
inserted into the 
injector 

PlungerUp： 

When the syringe is 
pulled out from the 
injector 

Injector Penetration 
Depth 

Depth to insert the 
syringe into the injector 

40mm 15-50mm  

Continuous Purge Specifies whether or not 
to purge the syringe 
continuously except 
during sampling to 
injection. 

False True 

False 
Select "True" to 
perform purge. 
In this case, the 
parameter set for 
Pre/Post Purge 
Syringe is ignored. 

Advanced Group 

Enable Pre Filling Specifies whether or not 
to pressure the vial 
before sampling 

True True 
Flase 

In the script of the 
previous version of 
AOC-6000 control 
software, it was 
False internally. 
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Parameter Name  Description Default Settable 
Range 

Remarks 

Filling Strokes Count Number of times to pump 
the sample in and out 
when sampling 

5 0-15  

Filling Strokes 
Volume 

Volume of pumping the 
sample in and out when 
sampling 

1.2mL 0-2.2mL  

Filling Strokes 
Aspirate Flow Rate 

Speed to take up the 
sample by pumping the 
sample in and out 

6mL/min 1-100mL/min  

Delay After Filling 
Strokes 

Waiting time after the 
sample is pumped in and 
out until the sample for 
injection is collected 

30s 0-60s  

Sample Aspirate 
Flow Rate 

Speed to take up the 
sample to be injected 

6mL/min 1-100mL/min  

Sample Post 
Aspirate Delay 

Waiting time from when 
the sample is collected 
until the syringe is pulled 
out from the sample vial 

0s 0-600s  

Sample Vial 
Penetration Speed 

Speed to insert the 
syringe into the sample 
vial 

25mm/s 1-75mm/s  

Injector Penetration 
Speed 

Speed to insert the 
syringe into the injector 

25mm/s 1-100mm/s  

Pre Injection Dwell 
Time 

Waiting time from when 
the syringe is inserted 
into the injector until the 
sample is injected 

3s 0-60s  

Post Injection Dwell 
Time 

Waiting time from when 
the sample is injected 
until the syringe is pulled 
out 

10s 0-60s  

Agitator On Time Time of the agitator’s 
rotation 

5s 1-600s  

Agitator Off Time Time that the rotation of 
the agitator is stopped  

2s 0-600s  
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1. Since AOC-6000 Control Software Ver.2.1, the default values of the following method parameters 
of Headspace Injection have been changed. Please be careful when upgrading from your software 
version 2.0. 

Group Parameter Name Default 

Ver.2.1 or later Ver.2.0 

Analysis Syringe Temperature 100℃ 105℃ 

 

2. Since AOC-6000 Control Software Ver.2.0, the default values of the following method parameters 
of Headspace Injection have been changed. Please be careful when upgrading from your software 
version 2.0 or earlier. 

Group Parameter Name Default 

Ver.2.0 or later ～Ver.1.3 

Analysis Incubation Temperature 80℃ 40℃ 

Incubation Time 45min 5min 

Syringe Temperature 105℃ 60℃ 

Pre Purge Time 0s 5s 

Injection Flow Rate 25mL/min 10mL/min 

Post Purge Time 60s 10s 

Advanced Enable Pre Filling True Set to “False” inside the 
method. 

Filling Strokes Count 5 0 

Filling Strokes Volume 1.2mL 2mL 

Filling Strokes Aspirate Flow Rate 6mL/min 12mL/min 

Delay After Filling Strokes 30s 0.5s 

Sample Aspirate Flow Rate 6mL/min 12mL/min 

Sample Post Aspirate Delay 0s 1s 

Sample Vial Penetration Speed 25mm/s 50mm/s 

Injector Penetration Speed 25mm/s 50mm/s 

Pre Injection Dwell Time 3s 0.5s 

Post Injection Dwell Time 10s 0.5s 
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Method Parameters for SPME Methods 

Parameter Name  Description Default Settable Range Remarks 

Analysis Group 

Fiber Tool Specifies the name 
of the syringe tool 
for SPME. 

  Select one from the list 
of syringe tools for 
SPME connected to the 
instrument. 

Conditioning Port Specifies the fiber 
conditioning port. 

  Select one from the 
pull-down list. 

Conditioning 
Temperature 

Temperature for 
fiber conditioning 

40C 40-350C  

Pre Conditioning 
Time 

Time of fiber 
conditioning 
performed before 
extraction 

0min 0-600min  

Incubation 
Temperature 

Incubation 
temperature for 
sample vials in the 
agitator 

40C (SPME Injection 
Method) 

30-80C 

 

(SPME Injection 
For High Boiling 
Solvent Method) 

30-200C 

Incubation Time Time to incubate 
sample vials in the 
agitator 

5min 0-600min  

Agitator Speed Agitator’s rotating 
speed 

250rpm 250-750rpm  

Sample Vial Depth Depth to insert the 
fiber needle into the 
sample vial 

22mm 8-70mm See Note. 

Sample Extract 
Time 

SPME time 10min 0-600min  

Injector Specifies the injector 
name. 

  Select one from the list 
of the injectors 
connected to the 
instrument (e.g. 
Injector1, Injector2). 

Sample Desorb 
Time 

Desorption time 1min 0-600min  

Post Conditioning 
Time 

Time of fiber 
conditioning 
performed after 
desorption 

3min 0-600min  

Analysis Time Interval to repeat 
analysis 

15min 0-600min The time is the total of 
the GC program time, 
cooling time, 
equilibration time, plus 
some additional time. 

Setup Group 

Gas 
Chromatograph 

Specifies the GC 
unit to be used. 

  Select one from the list 
of GC units connected to 
the instrument (e.g. 
GC1). 

Sync Before 
Extraction End 

Specifies the time to 
start the Cryo Trap 

0min 0-600min Use this parameter when 
Cryo Trap is installed on 
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Parameter Name  Description Default Settable Range Remarks 

Time operation by using 
the time before 
SPME ends. 

the GC unit. 
Set "0 min" when Cryo 
Trap is not used. 

Agitator Specifies the 
agitator. 

  Select one from the list 
of trays connected to the 
instrument. 

Do Agitation Specifies whether or 
not to vibrate (rotate) 
the agitator. 

True True 

False 
 

Heat Agitator Specifies whether or 
not to heat the 
agitator. 

True True 

False 
 

Wait For 
Readiness Agitator 

Specifies whether or 
not to wait until the 
actual temperature 
reaches the set 
value when setting 
the temperature of 
the agitator. 

True True 

False 
 

Internal Standard 
Station 

Specifies the 
position to place the 
internal standard 
solution vial. 

  Select one from the 
pull-down list. 

Internal Standard 
Position 

Specifies the index 
on the station for 
internal standard 
solution vial. 

1 1-70  

Injector Penetration 
Depth 

Depth to insert the 
fiber needle into the 
injector 

54mm 15-70mm  

Injection Signal 
Mode 

Timing to send the 
Start signal 

Before 
Expose 

Before Expose 

After Expose 
Before Expose： 

The Start signal is 
output when SPME is 
injected. 

After Expose： 

The Start signal is 
output when desorption 
starts. 

Advanced Group 

Internal Standard 
Adsorb Time 

Time for the internal 
standard solution to 
adsorb 

0min 0-600min  

Internal Standard 
Penetration Depth 

Depth to insert the 
fiber needle into the 
internal standard 
solution vial 

32mm 10-70mm  

Sample Vial 
Penetration Speed 

Speed to insert the 
syringe into the 
sample vial 

20mm/s 2-75mm/s  

Injector Penetration 
Speed 

Speed to insert the 
syringe into the 
injector 

100mm/s 2-200mm/s  

Agitator On Time Time of the 
agitator’s rotation 

5s 0-600s  

Agitator Off Time Time that the 
rotation of the 
agitator is stopped  

2s 0-600s  
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1. In this software, the definition of [Penetration Depth], which is the depth that the fiber needle penetrates 
for absorption and desorption of the sample in SPME or SPME Arrow, is the distance between the 
reference position and the tip when the fiber is pulled out.  
 
◼ Sample Absorption 
In sample absorption, the settings are configured as per the figure below. 
 

 
 
◼ Sample Desorption at the Injection Port 
The settings are configured as per the figure below in the case of sample desorption at the injection 
port. 
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◼ Conditioning 
The settings are configured as per the figure below in the case of SPME fiber and SPME Arrow 
conditioning. 
 

 
 
 

2. The table below shows the recommended sample volume for SPME and SPME Arrow methods by vial 
size. 
• SPME Injection 
([Sample Vial Depth] is set to 22 mm when the fiber length is 10 mm and 31 mm when the fiber length 
is 20 mm.) 

 

Vial Size 

Headspace Extraction Immersion Extraction 

Fiber Length 
10 mm 

Fiber Length 
20 mm 

Fiber Length 
10 mm 

Fiber Length 
20 mm 

10 mL 6 mL max Not recommended 9 mL Not recommended 

20 mL 15 mL max. 13 mL max. 18 mL 18 to 19 mL 

 
• SPME Arrow Injection 

 

Vial Size 
Headspace 
Extraction 

Immersion 
Extraction 

10mL Not recommended Not recommended 

20mL 13mL max 18 to 19 mL 
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Method Parameters for SPME Arrow Methods 

Parameter Name  Description Default Settable Range Remarks 

Analysis Group 

SPME Arrow Tool Specifies the name 
of the syringe tool 
for SPME Arrow. 

  Select one from the list 
of syringe tools for 
SPME Arrow connected 
to the instrument. 

Conditioning Port Specifies SPME 
Arrow conditioning 
port. 

  Select one from the 
pull-down list. 

Conditioning 
Temperature 

Temperature for 
SPME Arrow 
conditioning 

40C 40-350C  

Pre Conditioning 
Time 

Time of SPME 
Arrow conditioning 
performed before 
extraction 

0min 0-600min  

Incubation 
Temperature 

Incubation 
temperature for 
sample vials in the 
agitator and Stirrer 

40C (SPME Arrow 
Injection Method) 

30-80C 

 

(SPME Arrow 
Injection For High 
Boiling Solvent 
Method) 

30-200C 

Incubation Time Time to incubate 
sample vials in the 
agitator 

5min 0-600min  

Agitator Speed Agitator’s rotating 
speed 

250rpm 250-750rpm  

Stirrer Speed Stirrer’s rotating 
speed 

250rpm 0-1600rpm  

Sample Vial Depth Depth to insert the 
fiber needle into the 
sample vial 

33mm 8-70mm See Note. 

Sample Extract 
Time 

SPME Arrow 
sampling time 

10min 0-600min  

Injector Specifies the Arrow 
injector name. 

  Select one from the list 
of the Arrow injectors 
connected to the 
instrument (e.g. Arrow 
Injector1, Arrow 
Injector2). 

Sample Desorb 
Time 

Desorption time 2min 0-600min  

Post Conditioning 
Time 

Time of SPME 
Arrow conditioning 
performed after 
desorption 

3min 0-600min  

Analysis Time Interval to repeat 
analysis 

15min 0-600min  

Setup Group 

Gas 
Chromatograph 

Specifies the GC 
unit to be used. 

   

Wash Station Specifies the wash 
station to use for the 

  Select one from the 
pull-down list. 
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Parameter Name  Description Default Settable Range Remarks 

SPME Arrow solvent 
wash before 
extraction 

Do Pre Wash Specifies whether to 
perform the SPME 
Arrow solvent wash 
before extraction 

False True 

False 
 

Agitator Specifies the 
agitator. 

  Select one from the 
pull-down list. 

Stirrer Specifies the stirrer.   Select one from the 
pull-down list. 

Do Agitation Specifies whether or 
not to vibrate (rotate) 
the agitator and 
stirrer. 

True True 

False 
 

Heat Agitator and 
Stirrer 

Specifies whether or 
not to heat the 
agitator and stirrer. 

True True 

False 
 

Internal Standard 
Station 

Specifies the 
position to place the 
internal standard 
solution vial. 

  Select one from the 
pull-down list. 

Internal Standard 
Position 

Specifies the index 
on the station for 
internal standard 
solution vial. 

1 1-70  

Injector Penetration 
Depth 

Depth to insert the 
fiber needle into the 
injector 

54mm 15-70mm  

Injection Signal 
Mode 

Timing to send the 
Start signal 

Before 
Expose 

Before Expose 

After Expose 
Before Expose： 

The Start signal is 
output when SPME is 
injected. 

After Expose： 

The Start signal is 
output when desorption 
starts. 

Do Post Wash Specifies whether to 
perform the SPME 
Arrow solvent wash 
after desorption 

False True 

False 
 

Advanced Group 

Pre Solvent Index 

Index for the wash 
station used in the 
solvent wash before 
extraction 

1 1-4  

Pre Wash Time 
Solvent wash time 
before extraction 

0min 0-10min  

Pre Wash Vial 
Depth 

SPME Arrow 
insertion depth with 
respect to the wash 
vial for the solvent 
wash before 
extraction 

35mm 10-35mm  

Internal Standard 
Adsorb Time 

Time for the internal 
standard solution to 
adsorb 

0min 0-600min  
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Parameter Name  Description Default Settable Range Remarks 

Internal Standard 
Penetration Depth 

Depth to insert the 
SPME Arrow needle 
into the internal 
standard solution 
vial 

32mm 10-70mm  

Sample Vial 
Penetration Speed 

Speed to insert the 
syringe into the 
sample vial 

20mm/s 2-75mm/s  

Injector Penetration 
Speed 

Speed to insert the 
syringe into the 
Arrow injector 

100mm/s 2-200mm/s  

Post Solvent Index 

Index for the wash 
station used in the 
solvent wash after 
desorption 

1 4  

Post Wash Time 
Solvent wash time 
after desorption 

0min 0-10min  

Post Wash Vial 
Depth 

SPME Arrow 
insertion depth with 
respect to the wash 
vial for the solvent 
wash after 
desorption 

35mm 10-35min  

 

 

1. Since AOC-6000 Control Software Ver.2.0, the default values of the following method parameters 
of SPME Arrow Injection have been changed. Please be careful when upgrading from your 
software version 2.0 or earlier. 

Group Parameter Name Default 

Ver.2.0 or later ～Ver.1.3 

Analysis Stirrer Speed 250rpm 1000rpm 

Sample Vial Depth 33mm 40mm 
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Method Parameters for ITEX Methods 

Parameter Name  Description Default Settable Range Remarks 

Analysis Group 

ITEX Tool Specifies the name 
of the syringe tool 
for ITEX 

  Select one from the list 
of syringe tools for ITEX 
connected to the 
instrument (e.g. ITEX1, 
ITEX2). 

Trap Pre Cleaning 
Temperature 

Trap cleaning 
temperature before 
extraction 

250C 100-350C  

Trap Pre Cleaning 
Time 

Trap cleaning time 
before extraction 

300s 0-86400s  

Incubation 
Temperature 

Incubation 
temperature for 
sample vials in the 
agitator 

40C (ITEX Injection 
Method) 

30-80C 

 

(ITEX Injection For 
High Boiling 
Solvent Method) 

30-200C 

Incubation Time Time to incubate 
sample vials in the 
agitator 

5min 0.1-600min  

Agitator Speed Agitator’s rotating 
speed 

700rpm 250-750rpm  

Syringe 
Temperature 

Syringe 
Temperature 

70C (ITEX Injection 
Method) 

40-110C 

 

(ITEX Injection For 
High Boiling 
Solvent Method) 

40-150C 

Trap Extraction 
Temperature 

Trap temperature 
during extraction 

40C 30-150C  

Extraction Strokes Number of strokes 
during extraction 

10 0-99  

Injector Specifies the injector 
name. 

  Select one from the list 
of the injectors 
connected to the 
instrument (e.g. 
Injector1, Injector2). 

Injector Aspirate 
Flow Rate 

Intake flow rate at 
the injection port 

10μL/s 1-1000μL/s  

Desorb 
Temperature 

Trap temperature 
during desorption 

250C 50-350C  

Desorb Flow Rate Injection flow rate 
during desorption 

100μL/s 5-1000μL/s  

Trap Post Cleaning 
Temperature 

Trap cleaning 
temperature after 
desorption 

250C 100-350C  

Trap Post Cleaning 
Time 

Trap cleaning time 
after desorption 

0s 0-86400s  

Analysis Time Analysis time 15min 0-600min  

Setup Group 

Gas 
Chromatograph 

Specifies the GC 
unit to be used. 

  Select one from the list 
of GC units connected to 
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Parameter Name  Description Default Settable Range Remarks 

the instrument (e.g. 
GC1). 

Sync Before 
Incubation 

Specifies the time to 
start the Cryo Trap 
operation by using 
the time before 
sample vial 
incubation ends. 

0min 0-600min Use this parameter when 
Cryo Trap is installed on 
the GC unit. 
Set "0 min" when Cryo 
Trap is not used. 

Agitator Specifies the 
agitator. 

  Select one from the 
pull-down list. 

Heat Agitator Specifies whether or 
not to heat the 
agitator. 

True True 
False 

 

Sample Vial Depth Depth to insert the 
syringe into the 
sample vial 

15mm 10-35mm  

Water Removal Specifies whether to 
perform water 
removal 

Disable Disable 
Enable 

 

Water Removal 
Position 

Specifies the waste 
liquid bottle for 
dispensing the 
removed water 

  Select one from the 
pull-down list. 

Injection Signal 
Mode 

Timing to send the 
Start signal 

PlungerUp PreInject 
PlungerUp 
PlungerDown 

 

Injector Penetration 
Depth 

Depth to insert the 
syringe into the 
injector 

33mm 10-35mm  

Advanced Group 

Extraction Volume Sample aspiration 
volume during 
extraction 

1000μL 0-1300μL  

Extraction Aspirate 
Flow Rate 

Sample aspiration 
flow rate during 
extraction 

100μL/s 10-1000μL/s  

Extraction 
Dispense Flow 
Rate 

Sample dispensing 
flow rate during 
extraction 

100μL/s 10-1000μL/s  

Sample Prefill Rate Rate of aspiration 
volume from the 
sample after 
extraction 

40% 0-100%  

Water Removal 
Trap Temperature 

Trap temperature 
during water 
removal 

60C 40-150C  

Water Removal 
Purge Time 

Purge time during 
water removal 

0s 0-600s  

Injector Penetration 
Speed 

Speed to insert the 
syringe into the 
injector 

50mm/s 1-100mm/s  

Post Inject Delay Waiting time from 
when the sample is 
injected until the 
syringe is pulled out 

0s 0-600s  
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The typical sequence for the ITEX method is shown below. 
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